
 

  

CSP TIPS FOR WEBTOON DRAWING 
By hakei (@hakeism) 

─ 

 
This is formatted on a browser 
On the phone, it might look weird 

 

This is a collection of settings and tricks I know 

If your device blows up following this document, I’m not liable  

Feel free to suggest additional shortcuts and tips, and I can add them here  
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BEFORE YOU START READING 

CREDITS 

Many thanks to webtoon creators 두미두미 and 땍꾸 for their YouTube videos 

ASSUMPTIONS 
●​ This guide assumes a basic understanding of art &art programs  
●​ Some features will require Clip Studio EX  
●​ SketchUp won't be covered here  

FOR DEMONSTRATIONS & COMIC INDUSTRY KNOWLEDGE 
If you want to level up your game, I have a Coloso online class: Character-Driven Comics: Self-Pub 
to Industry 

 

SHORT FAQ - General 
●​ Clip Studio Pro or EX? 

○​ Try the free trial versions first.  
■​ If you're serious about comics, especially for printing, use EX  
■​ EX-only features: include managing multiple pages in one project file, 

auto-extracting line art from 3D, and exporting multiple pages with one 
button 

■​ Clip Studio goes on 40-50% sales around major holidays, including upgrades 
from Pro to EX 

●​ Scroll or traditional format? 
○​ Scroll format for Webtoon or Tapas, as they’re scroll platforms 
○​ If you have ANY plans to print: draw in the traditional format  

■​ Much easier to re-format traditional to scroll than vice versa  
1.​ But always make sure your comic is mobile-friendly 

a.​ Majority of modern audiences read from their phones 
2.​ Many creators draw in print format, then create a separate scroll 

version  
●​ Webtoon backgrounds? 

○​ Use SketchUp, Abler, and Clip Studio assets, Blender or even Sims the game. 
○​ You can also use Perspective Rulers to help draw your own or edit your photos 
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https://www.youtube.com/channel/UCt_R7nYqzKJ7Km_1X5BhEfA
https://www.youtube.com/channel/UCGvCAtXNwMzsTFwRZ_m_n5w
https://coloso.global/en/products/comicartist-hakei-us


●​ Average number of panels for an episode? 
○​ Contracted professionals: 50+ panels per episode   
○​ Indie creators can aim for 10-40+ panels, depending on the genre  

■​ Slice-of-lifes are okay with short episodes. For plot-heavy dramas, you need 
more  

■​ Rule of thumb: each episode should give something readers can react to, or 
an important information to digest 

●​ Panelling? 
○​ Study Scott McCloud’s Understanding Comics: The Invisible Art  
○​ Analyze successful webtoons/mangas  

■​ ex) to study how to open a series, gather the first chapters of the 5 
top-ranking webtoons/mangas of your genre, as well as other genres 

●​ Analyze what the first dialogue is, how the main character is 
introduced, how tone and stakes are established, etc.  

●​ Drawing takes too long? 
○​ Prioritize storytelling over detailed art  

■​ The average reader spends only 1-2 seconds on a panel  
○​ Focus on drawing faces and hair, as people spend the most time looking at them 

■​ Draw the big outlines first (ex: hair outline, clothing outline) 
●​ Add detail lines later when you have time  

○​ Simplified anime like Mob Psycho 100 is great at capturing visual 
information 

○​ Draw smart, not hard & take shortcuts  
●​ The harsh reality: many readers just want the next episode and will 

not sympathize if you hurt yourself drawing 
 

SHORT FAQ - Other 
●​ How do I build a readership? 

○​ You need to treat Webtoon/Tapas/other platforms as hosting sites and be active in 
social media promotions  

●​ Pay for online advertising? 
○​ Not recommended, as the results are usually minimal for the cost 

■​ Learn social media marketing strategies. It takes time and effort, but can lead 
to amazing (and free!) results 

●​ Slicing panels for uploading? 
○​ Webtoon and Tapas automatically slice images. Clip Studio EX also has an Export 

Webtoon feature  
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https://hakeism.com/blogs/hakei-rambles/using-social-media-for-webcomic-promotions


●​ HELP! My images look crunchy on the Webtoon app! 
○​ Export as PNG instead of JPEG  

●​ HELP! My files are too big for Webtoon! 
○​ Croppy is the best image compressor that doesn’t change your colors or trash the 

quality  
●​ Best time/day to upload? 

○​ Too many factors, but consistency is key. Let your readers know when to expect 
updates  

●​ Common font/size used? 
○​ Anime Ace (I use CC Wild Words) 
○​ Use a font that is clear and legible. 

■​ Handwriting is not recommended. But you can use free handwriting-to-font 
makers instead 

○​ Size depends on the canvas and DPI settings 
■​ Take a screenshot of a comic you like, and paste it to your canvas to gauge  

the size 

 

BRUSH/3D ASSETS 
●​ Clip Studio Assets store: brushes, 3D models, poses, effects, screentones, etc  
●​ Acon3D: SketchUp backgrounds, brushes, 3D models. Geared towards webtoons 
●​ SketchUp: for backgrounds 
●​ Abler: for SketchUp backgrounds  (ver1 is discontinued but free; ver2 is paid) 
●​ 3D Warehouse: for building SketchUp assets 
●​ CGTrader: various 3D assets, not all are suitable for CSP 
●​ SnapToon: A separate background software. Some models already on Acon 

FONTS 

●​ List of dialogue/SFX fonts used by scanlation groups 
●​ Manga font directory 
●​ Blambot: free and licensed fonts for dialogue and sound effects 
●​ Comicraft: mostly paid fonts 
●​ Google fonts: tons of free licensed fonts 

VIDEO GUIDES 

●​ Using and editing SketchUp for webtoon backgrounds 
●​ Using this doc’s template in action (this one will help with the Basic Workflow section)  
●​ Improving comic readability 
●​ Using the vector layer for lineart 

HOW TO DO PROMOTIONS 

●​ Using Social Media to Promote Your Comic 
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https://knicknic.github.io/croppy/
https://assets.clip-studio.com/en-us/
https://www.acon3d.com/en
https://sketchup.trimble.com/en
https://abler.world/en
https://3dwarehouse.sketchup.com/
https://www.cgtrader.com/
https://snaptoonwarehouse.com/shop/?lang=eng
https://imgur.com/a/scanlation-font-sheets-UmEpOL1
https://mangafonts.carrd.co/#inhouseedition
https://blambot.com/
https://www.comicbookfonts.com/default.asp
https://fonts.google.com/
https://www.youtube.com/watch?v=-xEX0Iu3y6M&feature=youtu.be
https://www.tiktok.com/@hkism/video/7023475199983078661?is_copy_url=0&is_from_webapp=v1&sender_device=pc&sender_web_id=7027228849885496838
https://www.tiktok.com/@hkism/video/7024974127849082118?is_copy_url=1&is_from_webapp=v1
https://www.tiktok.com/@hkism/video/7022810162792582405
https://hakeism.com/blogs/hakei-rambles/using-social-media-for-webcomic-promotions
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1.​GETTING STARTED 
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CANVAS SET UP 

A.​TEMPLATE 
 

My webtoon template: assets.clip-studio.com/en-us/detail?id=2208895 

 

You should modify it as needed. Save a changed template by going to Edit > Register Material > 
Template  

 

 

The green layer on top is to 
reduce eye strain while doing 
lineart 

You can turn it off while 
working on color 

 

 

Since it’s a ‘Draft’ layer, it 
won’t affect your exported 
images even when turned on  

 

(will be explained later in the 
document) 
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http://assets.clip-studio.com/en-us/detail?id=2208895


 

 

 

TIP 
 Important layers can be assigned colors for easy recognition  
 

 

 

 

B.​ SMARTPHONE SCREEN GUIDES 
 

No more than one or two webtoon panels 
per screen 

 

More than three, panels are too crowded 
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You can also use CSP’s webtoon previewer  

(View > On screen area (webtoon) and change the Height to your phone size 

 

 

 

 

 

Clip Studio also has Companion 
Mode, where you can preview a 
canvas on your phone   

 

(It rarely works for me though) 
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https://support.clip-studio.com/en-us/faq/articles/20220005
https://support.clip-studio.com/en-us/faq/articles/20220005


C.​ FRAME FOLDER 
​ Create the frames on a single frame layer 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10 



 

 

 

Use cut Frame Border for even spacing between two 
panels 

 

 

 

 

 

 

To change the space between the 
webtoon panels, go to: 

 

Edit > Change Canvas Height > 
Extend or Crop  

 

 

 

D.​DIALOGUE BALLOONS 
 

Two styles: diamond shape or rectangle 

 

Don’t forget to pad the space around the text, so it doesn’t 
feel choked by the balloons 

 

●​ No more than 3-4 words per line 
●​ 1-2 sentences per balloon  
●​ Read these free lettering basic tips  
●​ In webtoons, keep the balloons from touching the 

canvas edges 
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https://blambot.com/pages/lettering-tips


 

 

If you create your own balloons, save it as a Material  

(create an empty text balloon, then drag it to your 
Materials folder) 

 

 

Any Materials balloon that gets dragged over text will 
automatically center itself  

 

There are great hand-drawn balloons like this one in the 
Assets store 

 

 

 

 

 

E.​ DIALOGUE FONTS 

List of dialogue/SFX fonts used by scanlation groups 

 

Manga font directory 

 

 

You should differentiate these three at the 
minimum 
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https://assets.clip-studio.com/en-us/detail?id=1690397
https://imgur.com/a/scanlation-font-sheets-UmEpOL1
https://mangafonts.carrd.co/#inhouseedition


 

The more lettering styles under your belt,  

The better your comic looks 
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2.​LET’S WORK 
 

 

 

 

 

 

 

You can download an old episode file of mine here (Google Drive)  
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https://drive.google.com/file/d/1J3ery1LAeX35OEPbDhSjHlmknFRvR6FV/view?usp=sharing


BASIC WORKFLOW (Quick ver ) 

Simplify your layers, especially when working with others 
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 TIP 
I forgot to include this menu above, but the 
highlighted portion is the key  
 

 

 

BASIC WORKFLOW (Expanded ver ) 

A.​STORYBOARD/SKETCH LAYER 
Toggle the Draft button, so the layer is ignored by tools like Fill Bucket and during export 
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Make sure your paint bucket, color wand, etc. ignore 
Draft layers  
 

(Also useful to have them ignore Text layers)  

 

 

 

 

 

 

 

 

B.​ VECTOR LINEART LAYER 
 

Use vector layers for all lineart  

 

 

 

 

 

 

 

You can adjust the lineart’s thickness, size, brush shapes, 
etc., without killing the quality  

(More vector options at the Combine Models and Backgrounds 
section)  

 

 

When using Transform, you can change whether you want 
the width to change, too 
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These set of tools can help you manipulate vector lines  

 

 

 

 

 

 

 

 

 

 

 

Use the Vector Eraser for quick 
erasing   

 

(ex: one single eraser stroke can 
delete an entire line ) 
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https://www.clip-studio.com/site/gd_en/csp/userguide/csp_userguide/510_tool/510_tool_selct_line_edit.htm


 

 

TIP 
Anti-aliasing: weak or strong? 
Generally: 

Turn it OFF for printed black/white comics, for crisp lines 
on paper  

Turn it ON for digital/color comics, to be smoother and 
easier on the eyes  

 

(But, personal preference should be #1 ) 

 

 

C.​ FLAT BASE COLORS 
 

Set your main lineart layer as the Reference Layer   

 

 

 

 

 

This custom color bucket uses the 
Reference layer as a guide for where to 
fill colors 

 

 

You can also use this famous close and 
fill tool without gaps tool (the ice cream 
man)  
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https://assets.clip-studio.com/en-us/detail?id=1759448
https://assets.clip-studio.com/en-us/detail?id=1759448


 

 

 

 << an important setting  

 

 

 

 

 

 

Paint all the base colors on 
one layer   
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TIP 
Tiny gaps in the base 
colors can usually be 
“disguised” 

if you put dark grey 
behind them   

 

 

 

 

 

 

 

 

 

 

D.​SHADOWS/RENDERING 
 

Use a custom Selection Wand to 
select all of the same color on a 
layer at once 

 

 

This means you can do shading 
for that selected color quickly 

(ex: lay down all the shadows for 
browns; or change the airbrush 
color for all the reds) 
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<< an important setting 

 

 

 

 

 

 

 

In general: 

 

Multiply layer for shading  

 

Screen/Overlay/Hard Light layers 
for environmental lights 

 

Keep separate layers for airbrush 
effects, etc  

 

 

(Clip Studio v2 has a Shading Assist 
feature 

It’s wonky, but can be used as a 
starting point) 
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Use the Lasso Fill tool to draw/fill an area quickly, especially 
for cell-shading 

 

 

Figure > Direct Draw (or shortcut key 'U') 

 

 

 

 

 

 

 

 

 

 

 

TIP 
Obtain display color: grab colors of what you see on the 
screen, including any applied effects  

Pick up color from layer: allows you to grab the color of a 
layer 
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TIP 
If you want to mix colors manually, try 
changing the Mixing Mode to Perceptual 

 

It lets you mix as if you’re working with 
actual paint 
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TIP 
Adding saturation around your shadow/light edges make your art look more dynamic 

(Auto-actions like this one can help) 

 

 

TIP 
Rendering with shadows as 
the focus: objects look heavy 
and solid 

 

 

With light: objects look glossy 
and smooth 
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https://assets.clip-studio.com/en-us/detail?id=2203588


 

 

E.​ BACKGROUND 
 

 

If you’re drawing backgrounds, 
similar principles as above 
apply  

 

Using Layer Masks prevents 
images from overflowing to 
other panels  

 

 

 

 

 

 

 

 

 

 

TIP 
 
Layer Masks: “Erases” without actually erasing 
the image, so you can reverse at any time 
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3.​USE THOSE ASSETS 
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DRAW SMART, NOT HARD 

 

 

 

A.​3D MODELS 
 

Using 3D models cuts down time and saves your long-term health 

 

Clip Studio Assets store has tons of assets of all kinds, both free and paid   

Acon3D assets are pricey, but high-quality and geared for webtoons/color comics 

 

 

 

​
Models like these have 
built-in with lineart and 
clean colors 

 

​
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https://www.acon3d.com/en/toon/product/1000011874


Example: https://www acon3d com/en/toon/product/1000017333​
​
1.  Lineart is part of the 3D model​
2.  Flat colors are also part of the 3D model ​
3.  Turn on Shadows – Toon Shading setting (more info below)​
4.  Add effects  
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https://www.acon3d.com/en/toon/product/1000017333


B.​ 3D SHADOWS 

 

All 3D models have shadows that can be turned 
on/off 

 

 

 

 

 

 

 

 

 

 

 

In Clip Studio v3, models’ shadows can now interact with other models 

(This auto-action will help extract the shadows as cell-shading layers)
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https://assets.clip-studio.com/en-us/detail?id=2061343


 

We can change Clip Studio’s 
rendering & physics engine 

 

 (not all models are compatible 
with the physics)  
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C.​ 3D HEADS 

 

Clip Studio Ver 2.0 includes customizable heads 

 

 

 

 

 

 

 

 

 

 

 

 

 

TIP 
For heads that fit your 
style the closest,  

it’s best to use 3D 
programs like Blender 
(free)   
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https://www.blender.org/


1.​ Download a free head on 
CGTrader  

a.​ (make sure it’s not too 
high quality, or Clip 
Studio will lag when 
you import) 

 

2.​ Open it in Blender. Make 
sure the head is selected, 
and switch to the Sculpting 
tab (at the top) 

 

 

 

 

 

 

 

 

3.​ In the right menu, make sure Symmetry is turned 
on (if you want a symmetric face) 

a.​ Can be turned off when you make 
asymmetric changes 

b.​ If symmetric changes aren’t being made, 
then reposition the model by going back to 
the Layouts tab (at the top of program) 

 

4.​ When done, save as OBJ, FBX, or GLTF 
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https://www.cgtrader.com/search?free=1&keywords=head
https://www.cgtrader.com/search?free=1&keywords=head


D.​3D HANDS 

 

 

Clip Studio V2 includes a 
Hand Scanner that you can 
apply to hand models  

(I’m using this asset ) 

 

But tracing a photo of your 
own hand is faster and more 
accurate  

 

 

Finger positions can be locked so they don’t move 
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https://assets.clip-studio.com/en-us/detail?id=1895464


E.​ 3D BODY 

 

Create your character bases by customizing 
CSP’s base models  

 

 

Good for keeping character consistency 
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Clip Studio v4 lets you draw 
directly on CSP’s base models 
(more tips here) 

 

 

Useful for placing face, 
clothing, and tattoo guidelines 

 

 

 

 

 

 

 

 

 

You can also link objects to the model 
parts (like the above model’s hat) 

 

so you don’t have to manually re-adjust 
each time the pose is changed 

 

 

Click and drag objects inside the body 
model, and assign an Attachment Point 
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https://tips.clip-studio.com/en-us/articles/10747


 

TIP
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F.​ TURN 2D INTO 3D 

 

You can drag a 2D image to a base Primitive Shape (or some 
existing 3D layer) to move it around in a 3D space  
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 Other primitive shapes can do this, too  
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G.​3D ANGLES AND POSES 
 

Clip Studio’s store is full of free and 
paid poses 

 

so you don’t have to go through the 
trouble of posing everything from 
scratch 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dynamic angles can be made with Perspective, Roll, 
and Manga Perspective   
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TIP 
Turn OFF the Joint Angle Limit for easier posing 

 

 

 

 

 

H.​3D PERSPECTIVE RULERS 
Every 3D object comes with Perspective Rulers 

●​ Marquee (shape selection) tools will automatically change to fit the perspective 
while a ruler is on 

●​ To turn off/on the ruler, you can right-click and click Show Ruler  
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If these icons are turned on, your Brush/Pens will snap to 
any active rulers 

 

 

 

 

 

You can also display the 
ceiling/wall grids and change the 
grid cell size  

 

(To access this: select the layer rule 
icon with the Object tool) 

 

 

 

 

 

 

 

Clip Studio v2 added the Fisheye Perspective option 

(objects themselves don’t change, only the ruler) 
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I.​ TURN 3D INTO LINEART 
You can add CSP models directly to CSP 
backgrounds  

 

If needed, both the sizes of dolls and 
background models can be adjusted   

 

 

Right-click on the 3D Layer, and select 
Convert to Lines and Tones  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

44 



 

 

I typically use this setting: 

 

 

 

(Check the Preview box 
before committing ) 

 

 

(I sometimes turn on Extract 
Texture and Tone Work, 
depending on what sort of 
work I’m doing ) 

 

 

 

 

 

 

After extraction, use Vector Tools to help 
smooth or clean the lines  
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If things still look jagged for your liking, either: 

A)​ change the line’s brush 

Or B) rasterize the layer and then apply a Smooth filter 
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TIP: 
You can change the vector line’s brush type to fit 
your needs 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Change via Brush Shape menu 

 

(vector line color can also be changed 
through Main Color) 

 

 

 

Brush options can be added by: 
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J.​ 3D BACKGROUND MODELS 
 

Video Tip: Inma R showcased her editing Clip Studio backgrounds here  

 

 

Clip Studio V2 has a Fog option for 3D background 
assets, so you can apply perspective effects  

 

 

(What I did on the left:  

1.  Base 

2.  Enable Fog, added sky  

3.  Extract Line and Tone (applied shadow) 
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https://youtu.be/yzNj4s-oI_g?t=46


 

 

While changing the camera angle, if the buildings start 
to look too slanted,  

Use the Straighten Vertical Perspective option  

 

 

 

 

 

If the model has parts you’re allowed to 
manipulate, you can double-click on a part,  

and it’ll be automatically highlighted in the list 

 

 (you’ll know it worked if the selected part turns 
red) 

 

 

 

 

 

 

 

If there’s a no-editing-arrow on the model (like the 
screenshot) 

you can usually disable it by simply clicking on the 
icon  
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K.​ CHANGE MOOD WITH GRADIENT MAPS 

 

Gradient Maps can be 
used to change colors or 
the atmosphere 

 

(TIP: try setting a gradient 
map to Multiply, Overlay, or 
Hard Light  

All have different effects) 

 

 

 

 

 

 

Auto actions like this one 
can change the mood via 
one click  

Very handy, especially if 
you use it along with 
SketchUp   

(You’ll have to label layers 
beforehand so the auto 
action can work properly)  
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https://www.acon3d.com/en/toon/product/1000012481


L.​ SAVE FREQUENTLY USED HEADS/POSES/ITEMS 
¾ view to the side is a frequent one 

You can draw in advance all the head angles  

​
Video Tip: 66shark showcasing their asset saving process here  
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https://youtu.be/mZ5WKEk6Hzo


 

 

 

 

 

4.​NO STYLE, NO LIFE 
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WEBTOON COLORING STYLES 

A.​ SHADING COLOR
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https://twitter.com/hakeism/status/1512530506251862022


B.​ SIMPLIFIED STYLE  
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C.​ STRATEGIC COLORING 
I rarely render my panels 

And rely on gradients and color to carry the mood 

 

This cuts down my production time by a ton 

 

This sort of graphic style works best with thick, bold lineart 
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D.​MATCHING CHARACTER COLORS TO ENVIRONMENT 
Pick a mid-tone from the background  

Use the color on Hard Light and/or Multiply layer 

Using only one can make the colors look flat, so layer them with each other or pair with Overlay layers 

 

Gradient Maps can also be used, with its colors also picked from the background 

I set them to Multiply 
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5.​MORE CSP TIPS 
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KEYBOARD SHORTCUTS 
You can customize your keyboard shortcuts via File 
> Shortcut Settings 

 

Anything that requires your hand to stretch and 
strain should be simplified into buttons  

(ex: I set my Transform tool shortcut from ctrl+T into 
keyboard number 2) 

SELECTION WAND 
●​ Add to current selection: [shift] + 

select layer/color 
●​ Subtract from current selection: 

[alt] + select layer/color 

BRUSH 
●​ Change size: [ctrl] + [alt] + drag 

brush to size 

COLOR 
●​ Switch between foreground and 

background color: [x] 
●​ Switch between foreground and 

transparent color: [c] 

CANVAS 
●​ Change size: [ctrl] + [alt| + [C] 
●​ Zoom in/out: [ctrl] + mouse wheel 
●​ Move: Space bar 

LAYER 

●​ Hide all other layers except the 
selected: [alt] + select layer 

○​ Re-show all layers: [alt] + 
same layer 
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●​ Find what layer something is on: (while using the Move Layer tool) [ctrl] + [shift] + click 
on thing 

●​ Select all the pixels of a layer: (while on the Wand tool) [ctrl] + click the layer in the 
Layer window 

 

QUALITY OF LIFE/TOOL ORGANIZATION 
NOTE! Once you make changes, you have to manually back up your workspace settings via Cloud 

Otherwise, the next time you open CSP, it may revert to your last saved settings  

TOP BAR 
●​ Add shortcut buttons for frequently used Menus/ Filters/Auto actions 

○​ Right click on the header bar > Command Bar Settings 
○​ Icons can be rearranged via click + drag 
○​ Customize icons by right click > Icon Settings 

 

AUTO ACTION 
●​ A bit faster/easier to use if you change it to Button Mode 

○​ Click on the hamburger menu/ the three lines for Options 
●​ Go to organize, insert empty new sets with —----- as their names 
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BRUSHES 
●​ Click + Drag brush icons to create “catalogs” of them  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To make a catalog header (such as 
the “Tree” or “Sky”),  

 

first make a custom icon via a small 
square canvas, and save it as a 
JPG/PNG  

 

Then follow the steps in the pic > 
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6.​UPDATE LOG 
 

 

UPDATE LOG 
10/26/2021: Added more info 

12/7/2021: Added video section 

6/5/2023: Updated Clip Studio V2.0 info and more detailed screenshots.  Also more links.  Added CSP 
Organizing tips section.  Added information on 3D.  Added Table of Contents  

6/13/2023: Added select all pixels in the keyboard shortcuts  

6/18/2023: Added color gap mending tip and in FAQ the bit about paying for advertising  

6/27/2023: Added tip about moving two 3Ds together  
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10/24/2023: Added info on 3D section, about Acon’s models with lineart built in them.  Added links to 
66shark and Inma R’s youtube videos  

3/10/2024: Added info about Abler  

4/26/2024: Inserted an image about 3D primitives   

10/28/2024: Inserted resources link to Manga Font Directory and list of fonts used by scanlation groups 

9/20/2025: Added matching colors to the background section. Updated with new template link. Updated 
and re-ordered 3D models section. Added strategic coloring section. Edited sentences to be more 
skimmable. 
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